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ASLLL N32HT760 %1 MCU A, AR T WA #54 N32 Eclipse FF AW . &M T A
N32 MCU %%,

2R TH
2.1 %t

1) #¥A{ER%: WIN7/WINIO 64-bit OS

2) IDE: Eclipse IDE for GNU ARM & RISC-V C/C++ Developers
3) XM YiiFHE: arm-none-eabi-gee

4) #wPF 1L H: GNU MCU Eclipse build tools

5) GDB fi45#%: J-Link GDB Server

6) Hik#s: J-Link VO/V10

2.2 T

1) F &M N32H760xIx7-STB V1.0
2) JLink T#i#& V9 BiLL L
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IR EREE
3.1 %% ARM X X T B

» F# xpack-arm-none-eabi-gce-10.2.1-1.1-win32-x64.zip SCAF
Hbhk:  https:/github.com/xpack-dev-tools/arm-none-eabi-gcc-xpack/tags

1Jj 5] https://github.com/xpack-dev-tools/arm-none-eabi-gcc-xpack/releases/ ] 6 3% & H A A B A ) ARM 38 X
Y B

3.2 Build T E %3

> F# xPack Windows Build Tools v4.2.1-2-W32-X64.zip 3
Hibk: https:/github.com/xpack-dev-tools/windows-build-tools-xpack/releases/tag/v4.2.1-2/

1Jj I7) https://xpack.github.io/windows-build-tools/releases/F] % £ N #A F A I w3 T E .

3.3 Eclipse IDE 3%

3.3.1 JDK %%

> F# the jdk-8u202-windows-x64.exe 1

Eclipse % & 12 17 76 Java 3%, FT LLTE %2 %% Eclipse 2 Bl 7 B 5 % %% JDK . 1 http:/www.o
racle.com/technetwork/java/javase/downloads/java-archive-javase8-2177648.html ] % # N & A E A ) JDK T K.
ARICHESE jdk-8u202-windows-x64.exe NEIF A, 4% the jdk-8u202-windows-x64.exe A TERUG.

KA 22 $TJF dos fn AT 10, B java -version MR JDK 275 IEAfZ2%% . W IDK CLIEHh 2%,
CIECE ) PEr s

wn SR X +

Microsoft Windows [fZ4 10.0.26100.4349]
(c) Microsoft Corporation, {RE8FRERFI.

C:\Users\' >java —version

java version "1.8.0_202"

Java(TM) SE Runtime Environment (build 1.8.8_202-b8s)

Java HotSpot(TM) 6u-Bit Server VM (build 25.202-b88, mixed mode)

ER: AN, IEREA A B NI

3.3.2 Eclipse IDE for GNU ARM C/C++ Developers %3

> T Download the eclipse-embedcpp-2021-03-R-win32-x86_64.zip 3

Hiik: https:/www. eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/2021-0 3/R/eclipse-
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embedcpp-2021-03-R-win32-x86 64.zip.

ilAl https:/eclipse-embed-cdt.github.io/packages/releases/ 1] % % T # A [ Bk & 1 Eclipse IDE.

3.4 &3 JLink TR
> T JLINK &8/, v7.50 R A

https://www.segger.com/downloads/jlink/#-LinkSoftware AndDocumentationPack

[0 J-Link Software and Documentation Pack

_ Vers'“" —

J-Link Software and Documentation pack V7 50 v Windows
£
o AT G T S R [2021-07-01] 64-bit Installer & 32-bit Installer
= Can be downloaded and used free of charge by any owner of a SEGGER J-Link, J-Trace or
Flasher model. Linux
. 35;::‘;;:::;?;:;: may be available on all J-Link / J-Trace / Flasher models. & 64-bit DEB Installer & 32_bit DEB Installer
- Release Notes & 64-bit RPM Installer & 32-bit RPM Installer
» More information & 64-bit TGZ Archive & 32-bit TGZ Archive
Linux ARM
& 64-bit DEB Installer & 32-bit DEB Installer
& 64-bit TGZ Archive & 32-bit TGZ Archive
macOS

& 64-bit Apple Silicon Installer
& 64-bit Intel Silicon Installer

3.5 I B Xk

LAY JLink 2 J5 75 2L W) JLink FESMBBATA RS AN TA, DMEE T, R IR E R 85002
BRESE R (Glink T ENIN Nations 0 /.72

3.6 JLink &M

PR JLink FFEE %%

HERELF PC %ﬂj Link YHIXAS, BRI RN, FH;

2. THF cmd.exe AT L, HEN Jlink %235 H 3%“C:\Program Files (x86)\SEGGER\JLink V750" F, HiA
“JLink.exe”’;

=V

SEGGER J-Link Commander V7.50 (Compiled Jul 1 2021 17:43:13)
DLL version V7.50, compiled Jul 1 2021 17:41:53

Connecting to J-Link wvia USB...0.K.

Firmware: J-Link V9 compiled May 7 2021 16:26:12
Hardware version: V9.U@

S/N: 59417u52

License(s): RDI, GDB, FlashDL, FlashBP, JFlash
VTref=3.291V

Type "connect" to establish a target connection, '?' for help
J-Link>|
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B E#oR PC IEHE JLink W iAAs 5] -
SRIEMRAE SRR IRE A . “connect”, “N32H760XIX7”, “SWD”, “4000”, WIRATHKRIERD), WEER T
Ml L ILink FEBASF BT DUE 6 7 .
Type "connect" to establish a target connection, '?' for help
J-Link>connect
Please specify device / core. <Default>: N32H760XIX7
Type '?' for selection dialog
Device>
Please specify target interface:
J) JTAG (Default)
S) sWD
T) cJTAG
TIF>s
Specify target interface speed [kHz]. <Default>: UBBB kHz
Speed>
Device "N32HT76BXIXT" selected.

Connecting to target via SWD

InitTarget() start

FhF kAR hRdhhdhdhhRdhdbhddbdbhdbhddhdbhhbbibhhhhhhd

J-Link script: NationsTech Cortex-M7 J-Link script
dhkdhddhhdhhdhdbhRdhddhddbdbhdbhdhhbhbbibhhdhhhhd
InitTarget() end

Found SW-DP with ID ©x2BAO14T7

DPIDR: ©x2BA®1U4T7

AP map detection skipped. Manually configured AP map found.
AP[®]: AHB-AP (IDR: Not set)

AP[1]: AHB-AP (IDR: Not set)

AP[2]: AHB-AP (IDR: Not set)

AP[8]: Core found

AP[8]: AHB-AP ROM base: ©xE@EFFO00

CPUID register: OxU11FC272. Implementer code: @xi1l (ARM)
Found Cortex-M7 rlp2, Little endian.

FPUnit: 8 code (BP) slots and ® literal slots

CoreSight components:

ROMTbL[A] @ EGBFFEEA

ROMTbL[@][0]: E@EOEEee, CID: B1O5EEED, PID: B@EBBEOC SCS-M7
ROMTbL[@][1]: Eeeeleee, CID: B1O5EEED, PID: ©@EBBEO2 DWT
ROMTbL[@][2]: E@0O2000, CID: B1O5SEEED, PID: G@OBBEOE FPB-M7
ROMTb1[@][3]: Eeeeeeee, CID: B1O5EEED, PID: @@EBBEOL ITM
Cache: Separate I- and D-cache.

I-Cache L1: 32 KiB, 512 Sets, 32 Bytes/Line, 2-Way

D-Cache L1: 32 KiB, 256 Sets, 32 Bytes/Line, U-Way
SetupTarget() start

SetupTarget() end

Cortex-M7 identified.
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Eclipse #HA B NG EAE, Toi e, BHBEAE eclipse U2 R eclipse.exe K5 3l Eclipse, A2 5
W N ERTR.

— Eclipse IDE Launcher

X
Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

9 5
Workspace: | |2 ‘eclipse-workbase| w Browse...

[ Use this as the default and do not ask again

» Recent Workspaces

WK, EFEARM IS, Al workspace. A7 Launch. ¥ EIKASIREAR R, H#E YOS 5
Al LI BRI /e F A welcome BT AT F #f workbench FEIFRIE A 32 7LHT o

S eclipse-workspace - Eclipse IDE S ]
File Edit Source Refactor Navigate Search Project Run Window Help
i ‘ v v@j-m-gv@vag;vovgvgng.,- B:i%y o\
~ Bl kac Gy D | Q s
{5 Project Explorer 22 2 al =8 Eox > ]
There are no projects in your There is 1o, active editor
workspace. that provides an outline.
To add a project:
[E¥] in a directory containing
existing code
[ Create a new C or C++ project
[ Create a project..
[2] Problems 2 £ Tasks B Console [C] Properties o =
0 items
Description Resource Path Location Type
0 items selected % A
7 R AR A7FR 2 5 Nations Technologies Inc.
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4.2 % E Build TEKZ

7 Eclipse % 3% 612, ##57 Eclipse toolchain 3. # T H 2225 Ui I N #01 ARM 42 X 4 1%4E, Build T
B Ja B AL S RN, an T B PR

= " » eclipse > eclipse_toolchain > £ eclipse_toolchain 3%
Tl H= = 55
=R EEE Sl
xpack-arm-none-eabi-gce-10.2.1-1.1 2025/6/9 11:34 prg ==
xpack-windows-build-tools-4.2.1-2 2025/6/9 10:13 g L=

1) $THF Winodow->Preferences 1%

= eclipse-workspace - Eclipse IDE

File Edit Source Refactor Mavigate Search Project Run [Window| Help

e T - el [ E A New Window s
- - } - - | = Editor 4
. = Appearance L
5 Project Explorer ©3 B
5% 97 3 Show View r
. . i 3
There are no projects in your Perspective
workspace. Mavigatian r
To add a project:
i ) Preferences
Create a new Makefile project

|l [E9 ina directory containing
existing code

@ Create a new C or C++ project

4 Create a project..
Ex Import projects...

2) % $& MCU->Global  Build Tools Path , ¥ B 4 /& Build L. H i & :
${eclipse_home}\eclipse_toolchain\xpack-windows-build-tools-4.2.1-2\bin, X H 75 £ 0 B AN BEAE

8 A AR A3 7 FR A 5] Nations Technologies Inc.
Hhhk: PRINTTRS L X R AL E IR 109 S EREAKAE
FHIE: +86-755-86309900 %FL: +86-755-86169100
R4 : info@nationstech.com ER%w: 518057



~) 1 <’\
"" Eﬁiﬁm Nation \" www.nationstech.com

ERRK
= Preferences O X
type filter text | Global Build Tools Path =l v 8
Changelog " The locations where various Eclipse Embedded CDT build tools are installed. Unless defined marn
Docker warkspaces.
Help

F)uild toals folder: | ${eclipse_home}\eclipse_toolchain\xpack-windows-build-tools-4.2.1-2\bin I

Install/Update
Library Hover
v MCU
Global Arm Toolchains Paths
| Global Build Tools Path |

Global OpenCOCD Path
Global pyQCD Path
Global QEMU Path

P I R YT W N (Y P S R PR I

< >

@. By 223 @ |Apply and Closel Cancel

43 REX X HELARE

% MCU->Global Arm Toolchains Path, 1% B 4> J5 Arm Toolchains . E % £ .
${eclipse_home}\eclipse toolchain\xpack-arm-none-eabi-gcc-10.2.1-1.1\bin

— - — T
type filter text Global Arm Toolchains Paths Sro- i
Changelog m Configure the locations where various GNU Arm toolchains are installed. The values are stored within Eclipse. Unless redefined

» Docker B e e el G dl e ol e s
» Help Default toolchain: |xPack GNU Arm Embedded GCC -

. Install/Update
> Library Hover
4 MY [Tuclchain folder:  ${eclipse_homefeclipse_toclchain\xpack-arm-none-eabi-gee-10.2.1-1.1\bin I Browse... *Pack...
.
Global Build Tools Patl
Global OpenQCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Warkspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Path
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

Toolchain name:  xPack GNU Arm Embedded GCC

m

o - i [Restore Defaults| [ Apply |
@' @ 1247 @ [App\y and Close]l[ Cancel ]
9 A AR A3 7 FR A 5] Nations Technologies Inc.
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4.4 ¥t B SEGGER J-Link Path

1% #% MCU->Global SEGGER J-Link Path, % & 4:/5 SEGGER J-Link T H#84%, iX BikFEA ML HE, A4
HH #8424 C:\Program Files\SEGGER\JLink75

Y
= Preferences

type filter text

> General

v CfC++

Appearance
Autotools

Build

CMake

Code Analysis
Code Style

Core Build Toolcha
Debug

Dacker Container
Editor

File Types

WO W

W

WOW W

Indexer

Language Mapping
» MCU Packages
Meson
MNew CfC++ Project
Profiling

Property Pages Set
Tack Tans

WO W

a X

Global SEGGER J-Link Path e v 8

Configure the location where SEGGER J-Link is installed. The values are stored within
Eclipse. Unless redefined more specifically, they are used for all projects in all
workspaces.

After installing SEGGER updates, restart Eclipse for the defaults to be re-evaluated and
use the Restore Defaults button to configure the new location.

Executable: JLinkGDBServerCLexe

Folder: C\Program Files\SEGGERYJLink75 Browse... xPack...

Restore Defaults Apply

X Bk Eclipse IDE (4 #0ALE .

10 R AR A7FR 2 5 Nations Technologies Inc.
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SDK #YH LK i) SDK hicA, HEIEH v1.0.0, FERCEEA EMan MESLLERL Eclipse JT A .

5.1 HE T

1.¥TJF Eclipse, fE“File->New” | iJi£ 412 C/C++ Project, #%EF#: C Managed Build.

= eclipse-workspace - Eclipse IDE

Edit Source Refactor Navigate Search Project Run Window Help

New Alt+Shift+N » | ¥ Makefile Project with Existing Code
Open File... I ¥ C/C++ Project
(, Open Projects from File System... i Project..

2 ’ 'IJ Y 3 = 2 [ Create a new C or C++ project i
Seeentbies [c5] Convert to a C/C++ Autotools Project
Close Editor Ctrl+W Convert to a C/C++ Project (Adds C/C++ Natu
Close All Editors Cirl+Shift+W | &% Source Folder
Save Ctrl+S @ | Folder
i > ¢ Source File
Save As... = .

Save All Ctrl+Shift+S E I-feader Eie
Revert [ File from Template
& Class
Move... .
Rename... F2 | Bample
&1 Refresh F5 | Other..
Convert Line Delimiters To >
Print... Cirl+P
g  Import.
3 Export.
Properties Alt+Enter
Switch Workspace »
Restart
Exit b L =a
2.3 C Managed Build
= Mew C/C++ Project ] T -]
Templates for New C/C++ Project
_ € Managed Build &
CMake \‘CE * A C Project build using the CDT's managed build
Make system.
Meson
’ C++ Managed Build =
‘gc': * A C++ Project build using the CDT's managed build
spstent.
CMake Project |
A CMake project with a Hello World executable to get
started.
Empty or Existing CMake Project
Create 3 CMake project with no files. Can be used to
create one over existing content.
4 - - . - | +
@ o e

11
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3.5\ Projectname, FCE LMY, Ny 1 7 (a0 LS Workspace H . ZwiFiELA ARM Cross
GCC

Project name: F'rnjecti

[ Use default location

Location: ary.1.1.00projects\n32h76x_EVAL\examples\GPIO\LedBlink\Eclipse Browse...

Choose file system: default

Project type: Toolchains:

GMU Autotools Arm Cross GCC
Executable Cross GCC

Empty Project RISC-V Cross GCC
Hello World ANSI C Project

Hello World Arm C Project

Hello Waorld RISC-V C Project

ADUCM36x C/C++ Project

Hello World Arm Cortex-M C/C++ Project
Freescale Processor Expert C/C++ Project
Freescale Kinetis Koo C/C++ Project

¢ ¢ ¢ @ ¢ e EE

4. % Eclipse IDE CIE#fi% & T ARM Toolchains Path, 1X B2 H 31k 5. # Eclipse IDE KX E ARM
Toolchains Path, 4 A]7EiX B %&£ %] ARM Toolchains 44X #5452, SR )G iy “Finish” BI5ER% T TREAIEE S .

— O
GNU Arm Cross Toolchain —_—

Select the toolchain and configure path

Toolchain name: |xPack GNU Arm Embedded GCC (arm-none-eabi-gec) v
Toolchain path:  ${eclipse_homelieclipse toolchain\xpack-arm-none-eabi-gcc-10.2.1-1.14bin Browse...
12 E R AR F PR 4 7] Nations Technologies Inc.
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1. At LFE4, 1%+ new->Folder

www.nationstech.com

la .bc Projq* PP S O

4 In| New » | Project...
‘ L@“ Go Into < Fle
’ LE“H Open in New Window L File from Template
B showln Altsshitsw > |5 Folder
Show in Local Terminal » & Class
[E Copy [n] Header File
Paste |¢] Source File
K Delete &Y% Source Folder
i " C/CH+ Project
Moves [c5] Convert to a C/C++ Project (Adds C/C++ Nature)
Rename...
_—
L (T ™ Example...
=0 Oale bl o B

2. 553 5T STARTUP, BSP, CMSIS, DOC, FWIB, LD, SVD, USER KT R {32

Enter or select the parent folder:

Project

=
b =% Project

Folder name: |BSP

== Advanced

() [= Use default location

0 (7 Folder is not located in the file system (Virtual Folder)

() g Link to alternate location (Linked Folder)

Variables...

13

B AR NZ {345 FR 4y 5] Nations Technologies Inc.
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File system 1
Import resources fram the local file system. LK—/A.

From directory: | DALMM\eclipse-warkbase\Mationstech.N32H76x_78x_Library.1 V| Browse...

[ - I @ (g delay.c
@ [clogc
Filter Types... Select All Deselect All
Into folder: Project/BSP Browse...
Options

] Overwrite existing resources without warning

[C] Create top-level folder

== Advanced

iCreate links in workspacei

B Create virtual folders
B Create link locations relative to: PROJECT_LOC ~

?\ = Back MNext = Cancel
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4 FNERE, AR R BTN
v (2= Project (in Eclipse)
3 :jf Binaries

» [ Includes
» (B STARTUP

e
> [g) delay.c
> [ log.c
v G CMSIS
> g} system_n32h76x_78x.c
» = Debug
v g DOC
5 readme.txt
> gy FWIB
v g LD
g n32h76x_78x_flash.ld
v = SVD
= N32H76x.svd

=l

“ [ USER

> g main.c
> g n32h76x_78x_it.c

5.3 TEARCE

531 kR

Hiii TAE, 1&$E TIZJEME Properties JEIFTH, 7E“C/C++ Build->Settings->Tool Settings->Target Processor”
BCE AT ARHE B AR N A%, 1EFE cortex-m3 . cortex-md. cortex-m0 % cortex-m7. 7EAS 1, EFF cortex-
m7, WHE PR
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— Properties for Project

type filter text

» Resource
Builders
~ C,(C++ Build
Build Varlables
Environment
Logging
|
Tool Chain Editor
v C/C++ General
» Code Analysis
Documentation
File Types
Formatter
Indexer
Language Mapping
Paths and Symbols
Preprocessor Inclu

Profiling Categorie:

Linux Tools Path
> MCU
Project Matures

Task Repository
Task Tags
» Validation

Project References
Run/Debug Settings

Settings

Configuration: Debug [ Active ]

& Tool Settings ¥ Toolchains

B Devices

[ Container Settings # Build Steps Build Artifact

(¥ Target Processor
) (22 Optimization
(22 Warnings
(2 Debugging
w 8 GMU Arm Cross Assembler
(% Preprocessor
(% Includes
2 Warnings
(& Miscellansous
w [ GNU Arm Cross C Compiler
@ Preprocessar
22 Includes
# Optimization
=2 Warnings
# Miscellaneous
w B3 GMU Arm Cross C Linker
% General
(% Libraries
# Miscellaneous
w 8 GMU Arm Cross Create Flash Image

W -

Arm family (-mcpu) [cortex-m7

Architecture (-march) Toolchain default
Instruction set Thumb (-mthumb)

[ Thumb interwork (-mthumb-interwork)

Endianness Toolchain default
Float ABI Toolchain default
FPU Type Toolchain default

Unaligned access Toolchain default

[ TrustZone (-mcmse)
Generic (-mcpu=generic)
Toolchain default
Toolchain default
Toolchain default

Enabled (+simd)

5.3.2 fith S HK AL E

#£C/C++ Build->Settings->Tool Settings->Optimization” eI B, wi%-00.-01.
-02., -03., -Os. -Ofast. -Og.

— Properties for Project

type filter text

» Resource
Builders
Build Variables
Environment
Tool Chain Editor
v C/C++ General
> Code Analysis
Documentation
File Types
Formatter
Indexer
Language Mapping
Paths and Symbaols

I} [ |

Settings

W

W

i Target Processor

||
v

@ Debugging
B3 GMNU Arm Cross Assembler
(2 Preprocessor
(# Includes
(#2 Warnings
(# Miscellaneous
B3 GNU Arm Cross C Compiler
@ Preprocessor
(2 Includes
(# Optimization
(2 Warnings
(# Miscellaneous

w I8 GMNU Arm Cross C Linker

Optimization Level None (-00)

B Message length (-fmessage-length=0)

B 'char' is signed (-fsigned-char)

B Function sections (-ffunction-sections)

B Data sections (-fdata-sections)

[CJNe common unitialized (-fno-common)

[CJ Do not inline functions (-fno-inline-functions)

[ Assume freestanding environment (-ffreestanding)

[C] Disable builtin (-fno-builtin)

[l Single precision constants (-fsingle-precision-constant)
[CJ Position independent code (-fPIC)

[ Link-time optimizer (-flto)

] Disable loop invariant move (-fno-move-loop-invariants)

Ctther optimization flags

16
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3.3 GNU Arm Cross C Compiler ZAE

{E“C/C++ Build->Settings->Tool Settings->GNU Arm Cross C Compiler” &I H L & Cross C

S PRI o

A, E<Preprocessor->Defined symbols(-D)” i%& Tl 71 ¥% i CORE_CM7, N32H76x Fll
USE_STDPERIPH DRIVER i %%

= Properties for Project

type filter text Settings
» Resource (# Target Processor [[] Do not search system directories (-nostdinc)
Builders (2 Optimization [[] Preprocess only (-E)
| c/C++ Build | -

- .
(22 Warnings Defined symbols (-D)
(# Debugging

~ B GNU Arm Cross Assembler
Logaging ® p N32H76x
(£ Freprocessor USE_STDPERIPH_DRIVER
g (# Includes
Tool Chain Editor
w CfC++ General

Build Variables

Environment

(# Warnings
(2 Miscellaneous
) w B3 GNU Arm Cross C Compiler
Documentation ey
i =2 Preprocessor
File Types Iﬂ'l_!?—,
22 Tncludes

Formatter

> Code Analysis

p (# Optimization
Indexer . (# Warnings
Language Mapping

Dogel s Coppenlns]

7t includes->Include paths™i% W H1 78 I AR 75 09k SR8 A5 . AEAMEI s :

"${ProjDirPath}/../../../../../../firmware/n32h76x_78x std periph driver/inc"
"${ProjDirPath}/../../../../../../firmware/CMSIS/core"
"${ProjDirPath}/../../../../../../firmware/CMSIS/device"
"${ProjDirPath}/../../../../bsp/inc"

"${ProjDirPath}/../inc"

(2 Miscellaneous

5.3.4 GNU Arm Cross C Linker Bt B

£ “C/C++ Build->Settings->Tool Settings->GNU Arm Cross C Linker”fic & Cross C ##£1E . 7F“General
>Script files”ETHIMN:  "${workspace loc:/${ProjName}/LD/n32h76x_78x flash.Id} "
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Project

type filter text Settings

> Relsuurce (2 Target Processar Script files (-T)
Builders

# Optimizati -
C/C++ Build & Op Ir'rlnza en "${workspace loc;/${ProjName}/LD/n32h76x
@ Warnings
Build Vaniables

Enviranment

(£ Debugging

; v B3 GNU Arm Cross Assembler
Lolm (2 Preprocessor

. ke

o s Editor 2 Warnings

2 Miscellaneous

~ [ GNU Arm Cross C Compiler
(2 Preprocessor

v CfC++ General
» Code Analysis
Documentation

File Types (2 Includes
Formatter # Optimization
Indexer

. 2 Warnings
Language Mappings 2 Miscellaneous
Paths and Symbals

~ LGN Arm Cro Linker
Prepr‘ocessor In:!ude
Profiling Categories .
) TBraries
Linux Tools Path

» MCU
Project Natures

2 Miscellaneous
~ 3 GNU Arm Cross Create Flash Image

1 2 General
Project Re‘eremfes ~ 3 GNU Arm Cross Print Size
Run/Debug Settings (& General
Task Repository
Task Tags [[JDo not use standard start files (-nostartfiles) ]
» Validation [[JDo not use default libraries (-nodefaultlibs)

WikiText

I— Remove unused sections (-Xlinker --gc-sections)

(] Print removed sections (-Xlinker --print-gc-sections)

[CJ Omit all symbol information (-s)

Id JUAS A7 5 15 UREEFE RS, G PR S8 I P $AT S anfrT BE B N A ARG 1d AR ROAZ 4556 H R0 ) FLASH
K SRAM K/ P T s N A EC B
B TEDUHZIE “Do not use standard start files”

1E Miscellaneous iE Wi, “A)i%k Use newlib-nano & Do not use syscalls. (A EALARAL KN

=] Properties for Project

type filter text Settings
» Resource (8 Target Processor Linker flags (-Xlinker [option])
Builders (& Optimization
2 Warnings
Build Variables (= Debugging
Environment ~ 8 GNU Arm Cross Assembler

Logaing (% Preprocessor
Tool Chain Editor (£ Warnings

~ CJC++ General # Miscellaneous

> Code Analysis ~ 3 GNU Arm Cross C Compiler
Documentation (% Preprocessor Other objects
File Types # Includes
Formatter # Optimization
Indexer & Warnings
Language Mappings = M

Paths and Symbols ~
Preprocessor Include General
Profiling Categories L i
Linux Tools Path (& Miscellaneous
> MCU ;| Tate Flash Image
Project Natures (2 General Generate map "${BuildArtifactFileBaseName}.map”
Project References ~ ) GNU Arm Cross Print Size [ Cross reference (-Xlinker --cref)
Run/Debug Settings % General (] Print link map (-Xlinker --print-map)
Task Repository I @ Use newlib-nano (--specs=nano.specs) ]
Task Tags [(JUse float with nano printf (-u _printf_float)
» Validation [_] Use float with nano scanf (-u _scanf float)
WikiText

I @ Do not use syscalls (--specs=nosys.specs) ]
[CIVerbose (-v)

Other linker flags
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#£4C/C++ Build->Settings-> Build Steps” i 8N4, A5k bin/hex A+,
ABHE8I0: arm-none-eabi-objcopy -O binary "Project.elf"  "Projectbin"; arm-none-eabi- objdump -D
"Project.elf" > "Project.dump"

‘S Properties for Project

type filter text Settings

» Resource .
Builders 3 Tool Settings &3 Toolchains ‘B Devices [0 Container Settings # Build Steps Build Artifact Binary Parsers

w|C/C++ Build Pre-build steps

Build Variables Command:

Environment |

Logging
Description:
Tool Chain Editor |

~ C/C++ General

> Code Analysis Past-build steps
Documentation E:ommand: :
File Types Iarm—none—eabi—objcopy -0 binary "Project.elf” "Project.bin”; arm-none-eabi- abjdump -D "Projectelf” = "Project.dump” I
Formatter —
Description:
Indexer

Language Mappings |

Paths and Symbols

Prepracessor Include

Profiling Categories
Linux Tools Path
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1%EF Project->Build Project M 4mi a1 THE, REIRGIEZ AT 75 Ao i 4 u0 TR i, BN PENZ L—Ik
FI TR BEUGE, N T HIERIER,TE S clean TAE/E 5 builde 4wiF5Em)G, L EAE RO N elfs hex % bin 3¢

G

Fle Edit Source Refactor MNavigate Search Project Run Window Help
F'ﬁ' ||“-T?E%\®\|' - __| E:'ﬁvevgvggqv
- Fl e e m Q s H
3 De.. FoPr.. T O  [& mainc i = 8 w=v i ®%B STE =
S-S el
~ 2= Project (in Eclipse)
> f;.b Binaries
> @l Includes RCC_SetsysClkTonoded (s
_SetSys o 5
? @l STARTUP /* RCC configuration -------------------——--
v [ BSP RCC_Configuration();
3 delay.c /* L0G configuration ---------------omooomoo
@ | v log init();
» @ og.c /* GPIO configuration -------------------—-—-
¥ [y CMSIS GPIO_Configuration();
» system_n32h76x 78
L6t sy = = while (1)
» = Debug I
~ @y DOC GPIO SetBits(LED1_PORT,LEDL_PIN);
[ readme.td systick_delay ms(508);
F:VIB GPI0_ResetBits(LED1_PORT,LED1_PIN);
> bm systick_delay ms(5688);
v G LD }
5 n32h76x_78x flashl: }
v = SVD
El N32H76x.svd B Console & (2] Problems (2 Executables [ Debugger Console 4 Search T
- USER 1 E
%ﬁ@ , XG5 EEEE B -
N main.c ) DT Build Conscle [Project]
> [ n32h76x_78x_it.c = e
arm-none-eabi-ocbjcopy -0 ihex "Project.elf" "Project.hex"
Finished building: Project.hex
Invoking: GHU Arm Cross Print Size
arm-nene-eabi-size --format=berkeley "Project.elf”
text data bss dec hex filename
6576 8 8736 15328 3bd8 Project.elf
Finished building: Project.siz
89:88:53 Build Finished. ® errors, ® warnings. (tock 6s.146ms)
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TEEHAH, S Run—>Debug Configurations, it A\ Debug FCE 5 M. {1/ J-Link GDBServerCL {E4
GDB Server, i} GCC T E4EH ) GDB 1. EA{E N GDB Client. *{ili GDB SEGGER J-Link Debugging, #7
7%= J-Link [{fC & %50,

7.1 Main &I F

{E Main TR, SFEMET LR, —MBSENINAET TR W elf 3. WREE, mblid
Browse, Fausin elf X4

= Debug Configurations O X

www.nationstech.com

Create, manage, and run configurations

G = x| = Mame: Project Debug

| E| Main| %% Debugger | b+ Startup | 5 Source| [C] Comman| &, SVD Path
€] ¢/C++ Application
[€] C/C++ Attach to Appli
[E] C/C++ Container Laun Project Browse...
[E] C/C++ Pastmortem Di| | C/C++ Application:
[£] C/C++ Remote Applic
Cit C/C++ Unit
[c] GDB Hardware Debug Variables... Search Project.. Browse...

Project:

Debug\Project.elf ]

~ [£] GDB OpenOCD Debug Build (if required) befare launching
€] New_configuration

[&] GDB PyOCD Debuggir Build Configuration: | Select Automatically v
E GDB QEMU Debuggin (C) Enable auto build () Disable auto build

~ [T] GDB SEGGER J-Link Dy
[E Project Debug ]
i Launch Group

© Use workspace settings Configure Workspace Settings...

7.2 Debugger &=

7f Debugger i£Ti£H, HE HFrH 'S Device name, A9 A4 N32H760x1x7.

HAEFE T Eclipse RGN O IEFARL E J-Link #8545, 1X B B 2000 2R 2 A IERARC & , th 7] 7E Executable
path #2, %" J-Link GDBServerCL H44 %} 4%

ER: HENSRS, EMER J-Link K30 02015 R
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= Debug Configurations [m] *
Create, ge, and run configurati

CEeR x' B Y - Mame: Project Debug

| Main | %5 Debugger]b Starlup| 7] Source| i Qommon| =, SVD Path|
[T] C/C++ Application J-Link GDB Server Setup -

[E] C/C++ Attach to Applicatio B start the J-Link GDB server locally [[J Connect to running target
[€] C/C++ Container Launcher

[E] C/C++ Postmortem Debug

[E] C/C++ Remote Application Actual executable: C:\Program Files\SEGGERYJLink75')LinkGDBServerCL.exe
Cif C/C++ Unit

(to change it use the global or workspace preferences pages or the project properties
[£] GDB Hardware Debugging Dot N32H760xb? 5 d deui
. : pport
- E GDB DPenDCD Debugglng evice name: X u oree: evice r

Executable path: [ C:\Program Files\SEGGER\JLink7 3\JLinkGDBServerCL.exe Browse... I Variak

[&] New_configuration Endianness: O Little (O Big
[£] GDB PyOCD Debugging Connection: O UsE (o] (USB serial or IP name/address)
[£] GDB QEMU Debugging Interface: Oswo  OJTAG
v Eé[)lfr;iie;::;;mk Debug Initial speed: O Auto () Adaptive © Fixed 1000 kHz

@ Launch Group GDB paort: 2331
SWO port: 2332 B Verify downloads [ Initialize registers on
Telnet port: 2333 B local host only [ Silent
Log file: Brov
Other options: -singlerun -strict -timeout 0 -noqui v

Revert Apply
Filter matched 14 of 14 items = R

7.3 SVD Path E&TF

£ SVD Path e, EHE HAREF P 1 SVD 3.

= Debug Configurations O

Create, manage, and run configurations

G [ o B x| B Y~ Name: Project Debug

| Main |:%§ Debugger | B+ Startup B> Source|E Common | 7 SVD Path
[E] C/C++ Application SVD file (used by the peripheral registers viewer; may be .svd.zip)
[€] C/C++ Attach to Applicatio
[€] C/C++ Container Launcher
[€] C/C++ Postmortem Debug
[€] C/C++ Remote Application
Cif C/C++ Unit
[€] GDB Hardware Debugging

w [E] GDB OpenOCD Debugging

[£] New_configuration

€] GDB PyOCD Debugging
[£] GDB QEMU Debugging

w [c| GDB SEGGER J-Link Debug

| : Project Debug I

F Launch Group

File path: Dy \eclipse-workbase\Nationstech.N32H76x_78x_Library.1.1.0\pr¢  Browse.. Variables...
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7.4 Debug FH

Jlink #8514, Debug Configurations At & 52/l J5, s Debug, iE N Debug MK, 4R 1#:3] DEBUG
M, e LLIES R T

= eclipse-workbase - Project/USER/main.c - Eclipse IDE = O *

Eile Edit Source Refactor Mavigate Search Project Run Window Help

mild B D% ieblEdae s 2| SH-0- - ®@o ¢~

- Fl-es e - QBB

0. 2 GypPr. T O [g maine 22 [E] main{) at main.c:70 Ox15000460 =0 vz % =0
e k|3 § | Hr seio

v [£] Project Debug [GDB SEC o i) o° ..logj‘:.'. g

~ [ Project.elf 58 Mame

v o Thread #1 57005 (! 59 woid GPIO_Configuration(void);

= : ; 68 wvoid RCC_Configuration(void);
= main() at main.c - g ( )i

s JLinkGDBServerCLexe

s arm-none-eabi-gdb.e program.

s Semihosting and SW\

13 /
67= int main(void)

a8 {

69 /* Initialize system clock */

70 RCC_SetSysClkToModed();

71 /* RCC configuration ------------mmmmmmmmm e
72 RCC_Configuration();

73 /* oG configuration -----------mmmmmm e
74 log_init();

75 /* GPI0 configuration -------------c-cmmmeme
76 GPIO_Configuration();

78 while (1)

80 GPIO_SetBits(LED1_PORT,LED1 PIN);
81 systick_delay ms(5@0);

82 GPIO_ResetBits(LED1_PORT,LED1_PIN);
a3 systick_delay ms(500);

B console 2 il Regist... {2l Proble... {3 Execut.. Gl Debug.. [ Memeory 4 Search = O

|EREE 22 -5~

-ﬂ"'

Project Debug [GDB SEGGER J-Link Debugging]
egfper” itize=32 r2" tpui” t/> egs® btize=32 r3" tpflt/> egsl btize=32 r4" tpflt/> ¢

egfper” itize=32 r2" tpui” t/> egs® btize=32 r3" tpflt/: egsl btize=32 r4" tpflt/> ¢
eofree” itize=1? r3" tnni® Hiy eosh htizes17 r3" Fnfltds sosl hbizes32 rd" +nfltis s

Writable Smart Insert 70:1:3344
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E%%ﬁ@lﬁgﬁl" WATEESACH Eclipse T, fExmeed, sy File->Import , % F
General->Exisiting Projects into Workspace S AN F L2, siidi“Next”:

www.nationstech.com

e ]r'ﬂpﬂl't —m(n=ln

Select \“
Create new projects from an archive file or directory. H

Select an import wizard:

pe filter text x

IA = General I

13

Archive File
|. Existing Projects into Workspace
! [ File System

) Preferences
[ Projects from Folder or Archive
I’ s =% C/C++

m

] > = Git
» 2= Install b
i > = Oomph
| > (= RPM
> = Run/Debug A0
| EE—

® = Back Mext = Finish
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ERRK
P CA TR SCHRIER1E, Eclipse X iR M HIZZ FRIFTE TR, SEMMNK TR, Al
“Finish”, B[S ANIA T2,

= Import o X
Import Projects
Select a directory to search for existing Eclipse projects.
10 Select root directory: [D:\. . \eclipse-workbase\Nationstech.N32H76x_78x Library.1.0.0\projects\n32h76x_EVAL\examples\GPIO\LedBlink\Eclipse v| Browse...
() Select archive file: Browse...
Projects:
@ Project (D:\LMM\eclipse-workbase\Nationstech.N32H76x_78x_Library.1.0.0\projects\n32h76x_EVAL\examples\GPIO\LedBlink\Eclipse) Select Al
Deselect All
Refresh
Options
[l Search for nested projects
B Copy projects into workspa
[JClose newly imported projects upon completion
[CJHide projects that already exist in the workspace
Working sets
[ Add project to working sets New.
Select.
® < Back MNext = Cancel
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10. F=HH

EREARBDAER AT CRFR “EREAR” X SCRIE TR 8 KP4 N RILFE (1)
TR S5 20 U Rt F AR 3 FH A %, L SR B I A 53 1 [ R AR 2 i TR = ™)
NAFFTA -

H REEARTE IR TR FER BB ILARAT A E0 iR =AUV ] o BT 2 sk 51 FH 26
=T ARRERE () AHEX A2 B 1.

E RE AR EBER AR E . TIE. 50, BXOR R SR IRCR], BUR FBATE A W ALE
T B SR R ] R AR SR SRS R BT R A

] BB AR I8 B AR AT A5 B B, (HRIE it FEASHE E [ BB AR b SR e A P AT AT SR
AP THT.

1o FH U SRS A5 2 DA S AR il b B, (58 FH 3 N M AT A BRI BE T i AR IR IR L Th RE M Fn 22 4 1
(] BB ARAS XA AT PR A58 FH b SCRY AR 7= b 10 7= AR AT A L e (A0 oAb iR B30 sk AT
A A T 2 R AR BT

[ BB AR 77 S 7E R G ak 8 2% w1 87 FH 28R 38 A AT v WA BRPRAIE , o AT Ae] o 78 R AR 4
EA MBS DL T, AT REBUE N R T NS 3 B0™ B =40 2%, T eS8 R A0 “ A
A,

A AR EART: AMFRITFAREE. R FREEHIES . CHLECFEH WIS a3
)22 2 25 B DL R FoAth B A0 SCRP AR R AR I R

I A 22 4 il FH AR ARG 197 pl s N AR, ()oY N 2 A ) PR AR i IR DX A 22 4 i i 1
SEMVF. SR R AR E SR T R

XTI SCRY A= S AT B R « BROR ZARAE, SR EARR TER T 4 e FdE HE AR AL
IGRIE STAT, B RER AT e vEVa B W i AT S 5t

KA BIVFRT, ATA AAFS DT AA] R o6 e SO 430 BB b AT . B B0, PR AN
fE3E

27 B AR NZ {345 FR 4y 5] Nations Technologies Inc.
Mok RIITATRG L X R AL KR R 109 S EREAKE
HiE: +86-755-86309900 {5 : +86-755-86169100
HE4: info@nationstech.com EEZw: 518057



	1. 概述
	2. 开发工具
	2.1 软件
	2.2 硬件

	3. 开发环境搭建
	3.1 安装ARM交叉编译工具链
	3.2 Build工具安装
	3.3 Eclipse IDE 安装
	3.3.1  JDK安装
	3.3.2  Eclipse IDE for GNU ARM C/C++ Developers 安装
	3.4 安装JLink 工具
	3.5 添加芯片支持
	3.6 JLink下载测试

	4. Eclipse 启动及配置
	4.1 新建Workspace
	4.2 设置Build工具路径
	4.3 设置交叉编译工具路径
	4.4 设置 SEGGER J-Link Path

	5. 工程新建及配置
	5.1 新建工程
	5.2 文件夹新增以及文件导入
	5.3 工程配置
	5.3.1  芯片选择
	5.3.2 优化等级配置
	5.3.3 GNU Arm Cross C Compiler 宏配置
	5.3.4 GNU Arm Cross C Linker 配置
	5.3.5 配置生成 bin 文件

	6. 编译
	7. JLINK下载及调试
	7.1 Main选项卡
	7.2 Debugger选项卡
	7.3 SVD Path 选项卡
	7.4 Debug 界面

	8. 导入现有的工程
	9. 版本历史
	10. 声明

